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UPDATE

Free Computer Tips
During the last couple of months  our

user group has been approached by

Sharon Parq Associates with an offer

to provide us with free computer tips

each month for the benefit of our

members.The first four tips are included

in this issue. These are fairly simple

tips, easily understood and may prove

useful to know  when you are writing

that deathless prose for all posterity.

Word Processing
‘‘Inserting the total number of pages

in your document’’ on  Page 2 is one of

the Sharon Parq items.

‘‘Mixing Column Formats on a

Page’’ on Page 2 is another Sharon

Parq item on text formatting.

In Convert a PDF File To A Text File

the author, Sr. Dorothy Robinson, de-

scribes her success in using this utility

in converting a PDF file into an RTF file

which she could then edit. If you need

something like this, as I do as an editor,

then take a look.

In Understanding Digital Signa-

tures the authors open with this state-

ment: ‘‘Digital signatures are a way to

verify that an email message is really

from the person who supposedly sent

it and that it hasn’t been changed.’’

This tip focuses on digital signatures

for email messages. The purpose of the

digital signature is to verify the

authentiicity of the message. That is to

ensure that it is not a spoof or spam.

Spreadsheet Notes & Tips
‘‘Updating Values’’ on page 4 is

another Sharon Parq item, which notes

that Excel provides a quick way to

update values in a table by a uniform

amount. Simply follow these steps

given in the article.

‘‘Deleting a Hyperlink’’ on Page 5 is

the final Sharon Parq item in this issue.

It points out that just deleting the data

does not remove the attribute. You

need to take further steps to do that.

Operating System
In Eliminating Obsolete Windows

Device Drivers Vinny LaBash points

out that:When you upgrade or change

hardware, Windows doesn’t usually

delete the old device drivers. Some-

times these obsolete programs can

cause hardware conflicts. Seemingly

unrelated quirky behavior on the part of

the computer can often be traced to a no

longer used device driver. He then goes

on to tell you how to handle the situa-

tion.

In Best Windows Shortcuts Vinny  La

Bash reviews some of the basic key

commands that you can use with the

Ctrl key. He then discusses some func-

tions that you can perform with the so-

called Windows key in conjunction with

other keys. You may already know this,

but if not, take a look.

General Interest
In MotionDSP vReveal: Flawed

Video No More the author discusses a

software program that dramatically im-

proves video taken with hand held de-

vices.

In Ease US Partition Master Home

Edition the author discusses the use of

a program to repartition a hard disk.

In Lock Your PC With a USB Drive

the author Kim Kommando tells you

how to "lock" your computer using a

USB drive.

Communications
In Go Wireless Young Man the au-

thor points out that most new comput-

ers come with wireless capability built-

in. However, if your computer is older

than say, 2005, it may not have this

capability. He suggests where you can

look to check what is installed in your

computer.
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WORD PROCESSING NOTES & TIPS

Inserting the Total Number of Pages
in Your Document

It is not unusual to put a page number in your headers or

footers, if you choose to use headers and footers with your

document. You can also, however, insert a field that indicates

the total number of pages in a document. This can be used in

a header or footer or directly within the text of your document.

To insert the total number of pages in your document, follow

these steps if you are using a version of Word prior to Word

2007:

The Field Dialog Box

1. Position the insertion point where you want the total

number of pages to appear.

2. Choose Field from the Insert menu. You will see the Field

dialog box.

3. In the Categories list, choose Document Information.

4. In the Fields Names list, choose NumPages.

5. Click on OK.

The process of inserting a field is a bit different in Word

2007. Follow these steps:

1. Position the insertion point where you want the total

number of pages to appear.

2. Make sure the Insert tab of the ribbon is selected.

3. In the Text group, click Quick Parts. You’ll see a dropdown

menu.4. Choose Field. Word displays the Field dialog box.

5. In the Categories drop-down list, choose Document

Information.

6. In the Field Names list choose NumPages.

7. Click on OK to close the dialog box and insert your field.

Copyright (c) 2010 by Sharon Parq Associates, Inc. Re-

printed by permission. Thousands of free Microsoft Word tips

can be found online at http://word.tips.net.

Mixing Column Formats On a Page

It is not uncommon to have a document that mixes different

column layouts on a single page. For instance, let’s assume

you have a five-page document, and you want to format the

center part of page two as three columns. You want the rest

of the document to remain a single column. To overcome this

formatting challenge, you can follow these steps if you are

using Word 97 through Word 2003:

1. Select the text that will appear in the columns.

2. Choose the Columns option from the Format menu. Word

displays the Columns dialog box.

The Columns dialog box.

3. In the Number of Columns field, specify the number of

columns you desire.

4. In the Apply To box, make sure it says Selected Text.

5. Click on OK. Word places the selected text into its own

section and sets it in the number of columns you specified.

If you are using Word 2007, then the steps are a bit different:

1. Select the text that will appear in the columns.

2. Choose the Page Layout tab for the ribbon.

3. In the Page Setup group, click the Columns drop-down

list.

4. Pick the number of columns you want to use for the

selected text.

Copyright (c) 2010 by Sharon Parq Associates, Inc. Re-

printed by permission. Thousands of free Microsoft Word tips

can be found online at http://word.tips.net.

Convert a PDF File to a Text File
Sr. Dorothy Robinson, Newsletter Editor,

 Olympia Microcomputer User Group, Washington

http://olymug.org/   srdorothy(at)gmail.com

Have you been wishing you had a piece of software that

would convert PDF files to text files that you can edit? And

maybe also didn’t cost an arm and a leg?

BCL Technologies has such software called easyConverter

Desktop that costs about $20. That sounds like a good buy to

me. But it only works with Windows (2000, XP, Vista and Win

7). So that leaves a lot of people, namely Linux users, out in the

cold.

The good news is that BCL also has a free, online utility that

does the same thing. And your operating system doesn’t

come into it. Open your browser and go to <http://

pdfonline.com/pdf2word/index.asp> and take a look.

On the left side, under a header that says Convert PDF to

Word for Free you’ll see a place to browse your computer and
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select a file. Note that there is no need to provide your email

address, since you’ll just download the file directly.

Find your file and double click it (or click once then click

Open), then click the Upload and Convert button. Press it only

once, and wait; larger files may take a while to upload. The

conversion is pretty fast, under a minute for the one or two

page files I tried. There is a 2 MB limit on uploads, so really big

files won’t work.

This part is where, if you wanted to do a lot of files, or large

ones, it would be great to have an application on your

computer to do it--thus eliminating the time to upload.

The next step is downloading the text file. I’m not sure why

the instructions say to Right Click on the link to download the

file, because for me at least it didn’t work. I Left Clicked instead

and the download dialog opened.

You’ll see that the file is a rich text file (.RTF or .rtf) which

can easily be opened by Word, OpenOffice Writer, Abiword,

or other word processors or text editors and be available for

editing. When you save it you can save it as a .doc if you like.

The dialog asks, What should (your browser) do with this

file? The first choice is to open the file with the default

application (mine showed OpenOffice) or you can choose

another from a drop-down list.

 The second choice is to save the file, and if you choose Save

the file, your download manager will save it to the default

location--or you might get a Save as dialog and choose where

to save it. One caution: opening the file directly rather than

downloading it got me a Read Only file, which of course I

couldn’t edit. So for editing purposes, save the file before

opening.

Make your choice by clicking a radio button, then click OK.

You now have a text file you can edit. And the quality is very

nice, toofor mostly text documents. I tried a PDF file that I had

originally created in OpenOffice Writer which contained a

calendar in a table. The results were not pretty! And for a

postal PDF which was a requisition form using tables, the

results were somewhat better but still unusable since the

tables overlapped, hiding some of the text.

On the other hand, I made a list of data (several rows and

columns) in an OpenOffice spreadsheet, exported it to PDF,

then uploaded it and converted it. When I downloaded this

file, it was perfect--and perfectly editable.

For me, using Ubuntu Linux, this free, online version is a

good thing. Windows users have a choice of the web version

or the computer application. And pdf2word gives the best

results I’ve seen for this kind of web application.

This article has been obtained from APCUG with the

author’s permission for publication by APCUG member

groups; all other uses require the permission of the author

(see e-mail address above).

Understanding Digital Signatures
Authors: Mindi McDowell, Allen Householder

Copyright 2004 Carnegie Mellon University.

<www.us-cert.gov/legal.html> Terms of use

<--Published September 22, 2004-->

Digital signatures are a way to verify that an email message

is really from the person who supposedly sent it and that it

hasn’t been changed.

What is a digital signature?

There are different types of digital signatures; this tip

focuses on digital signatures for email messages. You may

have received emails that have a block of letters and numbers

at the bottom of the message. Although it may look like useless

text or some kind of error, this information is actually a digital

signature. To generate a signature, a mathematical algorithm

is used to combine the information in a key with the informa-

tion in the message. The result is a random-looking string of

letters and numbers.

Why would you use one?

Because it is so easy for attackers and viruses to ‘‘spoof’’

email addresses (see Using Caution with Email Attachments

<http://www.us-cert.gov/cas/tips/ST04-010.html>  for more

information), it is sometimes difficult to identify legitimate

messages. Authenticity may be especially important for busi-

ness correspondence--if you are relying on someone to pro-

vide or verify information, you want to be sure that the

information is coming from the correct source. A signed

message also indicates that changes have not been made to

the content since it was sent; any changes would cause the

signature to break.
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How does it work?

Before you can understand how a digital signature works,

there are some terms you should know:

���� Keys - Keys are used to create digital signatures. For every

signature, there is a public key and a private key.

���� Private key - The private key is the portion of the key you

use to actually sign an email message. The private key is

protected by a password, and you should never give your

private key to anyone.

���� Public key - The public key is the portion of the key that is

available to other people. Whether you upload it to a public

key ring or send it to someone, this is the key other people

can use to check your signature. A list of other people who

have signed your key is also included with your public key.

You will only be able to see their identities if you already

have their public keys on your key ring.

���� Key ring - A key ring contains public keys. You have a key

ring that contains the keys of people who have sent you

their keys or whose keys you have gotten from a public key

server. A public key server contains keys of people who

have chosen to upload their keys.

���� Fingerprint - When confirming a key, you will actually be

confirming the unique series of letters and numbers that

comprise the fingerprint of the key. The fingerprint is a

different series of letters and numbers than the chunk of

information that appears at the bottom of a signed email

message.

���� Key certificates - When you select a key on a key ring, you

will usually see the key certificate, which contains informa-

tion about the key, such as the key owner, the date the key

was created, and the date the key will expire.

���� ‘‘Web of trust’’ - When someone signs your key, they are

confirming that the key actually belongs to you. The more

signatures you collect, the stronger your key becomes. If

someone sees that your key has been signed by other

people that he or she trusts, he or she is more inclined to trust

your key. Note: Just because someone else has trusted a key

or you find it on a public key ring does not mean you should

automatically trust it. You should always verify the finger

print yourself.

The process for creating, obtaining, and using keys is fairly

straightforward:

���� Generate a key using software such as PGP, which stands

for Pretty Good Privacy, or GnuPG, which stands for GNU

Privacy Guard.

���� Increase the authenticity of your key by having your key

signed by co-workers or other associates who also have

keys. In the process of signing your key, they will confirm

that the fingerprint on the key you sent them belongs to you.

By doing this, they verify your identity and indicate trust

in your key.

���� Upload your signed key to a public key ring so that if

someone gets a message with your signature, they can

verify the digital signature.

���� Digitally sign your outgoing email messages. Most email

clients have a feature to easily add your digital signature to

your message.

There are a variety of mechanisms for creating digital

signatures, and these mechanisms may operate differently.

For example, S/MIME does not add a visible block of letters

and numbers within the message, and its digital signatures are

verified indirectly using a certificate authority instead of

directly with other users in a web of trust. You may just see

an icon or note on the message that the signature has been

verified. If you get an error about a digital signature, try to

contact the sender through a phone call or a separate email

address that you know is valid to verify the authenticity of the

message.

SPREADSHEET NOTES & TIPS

Updating Values

Many people use Microsoft Excel to keep track of important

information, such as price sheets or cost tables. This data is

then used to help calculate proposals or to figure out how

much should be charged to customers. It is not uncommon to

need to update information in these tables on a periodic basis.

For instance, your company may decide that it will increase all

prices in the company by ten percent this year.

If you have rather large pricing tables, you may not know

the best way to update the prices by the ten percent. Obvi-

ously you could make a secondary table and then base the

information in that table on a formula, such as =B3 * 1.1. This

is actually more work than is necessary, however. Excel

provides a much quicker way to update values in a table by a

uniform amount. Simply follow these steps:

1. Select an empty cell, somewhere outside the range used by

your pricing table.

2. Enter the value 1.1 in the empty cell.

3. With the cell selected, press CTRL+C to copy its contents

to the Clipboard.

4. Select the entire pricing table. You should not select any

headers or non-numeric information in the table.

5. Choose the Paste Special option from the Edit menu. Excel

displays the Paste Special dialog box.
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6. In the Operation area of the dialog box, make sure you select

the Multiply option.

7. Click on OK.

8. Select the cell where you entered the value in step 2.

9. Press the DELETE key.

The Paste Special Dialog Box

If you are using Excel 2007, then the steps are slightly different:

1. Select an empty cell, somewhere outside the range used by

your pricing table.

2. Enter the value 1.1 in the empty cell.

3. With the cell selected, press CTRL+C to copy its contents

to the Clipboard.

4. Select the entire pricing table. You should not select any

headers or non-numeric information in the table.

5. With the Home tab of the ribbon displayed, click the down-

arrow at the bottom of the Paste option (left side of the

ribbon). Excel displays a drop-down list of pasting options.

6. Choose the Paste Special option from the drop-down list.

Excel displays the Paste Special dialog box.

7. In the Operation area of the dialog box, make sure you select

the Multiply option.

8. Click on OK.

9. Select the cell where you entered the value in step 2.

10. Press the DELETE key.

That’s it! All the values in your pricing table now show a ten

percent increase from their previous values.

Copyright (c) 2010 by Sharon Parq Associates, Inc. Re-

printed by permission. Thousands of free Microsoft Excel tips

can be found online at http://excel.tips.net.

Deleting a Hyperlink

Part of Microsoft Excel’s compatibility with the Web is to

allow you to define hyperlinks in your workbooks. There may

come a time when you no longer need a particular hyperlink.

Fortunately, deleting a hyperlink in Excel is very easy to do.

All you need to do is follow these steps:

1. Right-click on the hyperlink. Excel displays a Context

menu.

2. Choose the Hyperlink option from the Context menu.

Excel displays a submenu.

3. Choose Remove Hyperlink from the submenu. Excel

dutifully removes the hyperlink.

You should note that in some versions of Excel (such Excel

2003 and Excel 2007) there is a Remove Hyperlink option

directly on the Context menu displayed in step 1. If this is the

case, consider yourself fortunate--you can directly remove

the hyperlink without the extra steps.

Don’t make the mistake of thinking that you can get rid of

a hyperlink simply by clearing a cell (moving to the cell and

pressing DEL). You can do this in the newer versions of Excel,

but you cannot in the older versions. If you do this, the

hyperlink text is gone, but the hyperlink itself is still lurking in

the background. If you type some information in the cell again,

you will notice it is underlined, indicating it is still a hyperlink.

The reason for this is because Excel considers the hyperlink

to be a format of the cell. Pressing DEL only clears the contents

of the cell, not its format. You can use other editing techniques

to get rid of a hyperlink, however, provided those techniques

result in getting rid of formatting or overwriting the formatting.

Copyright (c) 2010 by Sharon Parq Associates, Inc. Re-

printed by permission. Thousands of free Microsoft Excel tips

can be found online at http://excel.tips.net.
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OPERATING SYSTEM NOTES & TIPS

Eliminating Obsolete
Windows Device Drivers

by Vinny La Bash, <vlabash@comcast.net>

Sarasota Personal Computer Users Group, Inc.

Device drivers are programs that are designed to control

(drive) specific types of hardware (devices) that are attached

to your computer. These devices can be attached through

wires or by wireless connections. No matter how the device

is attached you need a program to tell it how to interact with

the computer. An operating system such as Windows comes

with myriads of device drivers built into it so when you bring

your new computer home, attach your printers, external drives,

etc., most of them work fine.

The caveat is that drivers are hardware dependent and

operating system specific so your external CD-ROM, which

worked flawlessly under Vista, may not work with Windows

7 until you install an updated device driver designed for the

new OS.

Every operating system directs device drivers to communi-

cate with their devices through the computer bus or a commu-

nications subsystem. It is a process which is largely invisible

to those trying to get work done on the computer, much like

the internal workings of an automobile are largely invisible to

a driver trying to get from home to the grocery store.

The invisibility of device drivers is a good thing when

everything is working smoothly, but it tends to hinder trouble-

shooting when trying to track down the cause of a problem.

When you upgrade or change hardware, Windows doesn’t

usually delete the old device drivers. Sometimes these obso-

lete programs can cause hardware conflicts. Seemingly unre-

lated quirky behavior on the part of the computer can often be

traced to a no longer used device driver.

Resolving device driver problems in Windows can be

difficult. In this article we’re going to focus on finding out-

dated device drivers and eliminating them from your system.

Manually searching for device drivers on a Windows

system can be frustrating, time-consuming, and mostly a

waste of effort. Conveniently for us, Microsoft has provided

a way to locate unused device drivers and remove them.

The directions herein are designed specifically for Win-

dows 7, but the general process will work for Vista and XP.

There are slight variations in the process with each of the

operating systems; just be careful when reading each screen.

Let’s get on with it.

The Device Manager as it comes from Microsoft is not set

up to display device drivers that are no longer being used. The

Device Manager has to be configured to show obsolete

drivers so we can remove them. You need to add something

called a special Windows Environment Variable. This is a text

string that contains a path, file name or drive. Programmers

refer to this as a system property. We don’t really care what

they call it as long as it works.

1. From the Start Menu, right-click on Computer.

2. Select Properties at the bottom of the list.

3. From the System window, select Advanced system settings.

4. From the System Properties dialog box, select the Environ-

ment Variables button. (See illustration)

5. The Environment Variables dialog box contains two pan-

els, User variables and System variables.

6. Click the New button.

7. In the New System Variable dialog box, type

devmgr_show_nonpresent_devices

8. Type 1 in the Variable Value text box.

9 .Close all the dialog boxes.

In most cases there is no need to restart the system. Let’s

test the results of our labor.

1. Access the Start Menu.

2. Right click Computer.

3. Select Manage.

4. When the Computer Management window appears, select

Device Manager.

5. Open the View menu and select Show Hidden Devices.

From now on whenever you open a branch within the

Device Manager tree structure and device icons are ‘‘grayed

out’’ or appear faded, these are the unused drivers. You can

safely delete them. Whenever you add, remove or change

your hardware configuration, always check for left over driv-

ers and avoid problems.

Copyright 2010. This article is from the April 2010 issue

of the Sarasota PC Monitor, the official monthly publication

of the Sarasota Personal Computer Users Group, Inc., P.O.

Box 15889, Sarasota, FL 34277-1889. Permission to reprint

is granted only to other non-profit computer user groups,

provided proper credit is given to the author and our

publication.
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Best Windows Shortcuts
by Vinny La Bash,  <vlabash@comcast.net>

Sarasota Personal Computer Users Group, Inc.

One of the better qualities of a good operating system like

Windows is that there is almost always more than one way to

do something. There are items you can select from a file menu,

use a shortcut or execute some kind of keystroke combination

to carry out an action.

There are some things you do almost every time you use

your computer. The six following shortcuts all use a similar

series of keystrokes. If you don’t know about these shortcuts

you probably haven’t been using computers for very long,

and you don’t know what you’re missing.

It doesn’t matter whether you’re working with music files,

photos, videos, documents, spreadsheets or portions of a

document. Simply highlight what you want with your mouse,

hold down the Ctrl key, then press and release the indicated

key. Don’t forget to release the Ctrl key when you’re done.

For example, to copy a file, some text or any object: Highlight

or select the item with your mouse and then hold the Ctrl

button down, press the C key and release. Ctrl+C To paste the

copied item or items: Ctrl+V (P was already taken for Print)

Sometimes you want to move an object from one location

to another: Ctrl+X

Select everything on a screen or in a folder: Ctrl+A

Print something: Ctrl+P (This is why you can’t use this

combination to paste).

Oops, I shouldn’t have done that: Ctrl+Z (Undoes your

mistakes)

Now that we’ve covered the basics, we can move on to some

good stuff. Microsoft introduced something called the Win-

dows key when it announced Windows 95 back in the Stone

Age. Also known as the Super key, Windows logo key, the

WinKey, the Start key, and sometimes the Flag key, it has been

with us ever since. Tapping the Windows key opens or closes

the Start menu. If that were all it did there would be nothing else

to say. There are several dozen shortcuts that you can easily

use with the Windows key in combination with other keys to

call up common functions. Here are a few of them:

Win+D: Shows the Desktop

Win+F: Opens the search function

Win+L: Locks the Desktop and lets you switch users

Win+M: Minimizes all open windows

Win+R: Opens the Run box so you can type DOS like com-

mands

Win+P: Very useful with multiple monitors or an external

projector

Win+Spacebar: All open windows become transparent so

you can see through to the desktop.

There are many others, but these are probably the ones most

computer users would invoke most of the time.

Microsoft sometimes does something really terrific, but for

whatever reason doesn’t tell anyone about it. The company

has created an alternate control panel which blows away any

tool I’ve previously seen. Why the company keeps it a secret

is beyond me. To create this tool you will need to create a

folder, name it, put in a period, and type something called a

Globally Unique Identifier (GUID). A GUID is a special type of

identifier used in software applications to provide a unique

reference number. The value is represented as a 32 character

hexadecimal character string. All you need to be concerned

with is to type it accurately. Let Microsoft’s engineers worry

about the details.

���� You can create the folder anywhere, but the most logical

place for it is on the Desktop. Make sure you’re on the

desktop and all windows are closed or minimized.

���� Right-click on an empty area of the desktop and choose

New/Folder.

���� Name the folder. It doesn’t matter what you call it, the magic

is performed by the GUID.

���� After the folder name, type a period.

���� After the period type the GUID {ED7BA470-8E54-465E-

825C-99712043E01C} (No spaces are allowed).

���� Press Enter

Open the folder and you have complete control over Win-

dows 7. You might need several hours to count how many

things you can do without having to hunt through layers of

screens to access an important, but obscure function.

Copyright 2010. This article is from the May 2010 issue of

the Sarasota PC Monitor, the official monthly publication of

the Sarasota Personal Computer Users Group, Inc., P.O. Box

15889, Sarasota, FL 34277-1889. Permission to reprint is

granted only to other non-profit computer user groups,

provided proper credit is given to the author and our

publication.
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GENERAL INTEREST

MotionDSP vReveal: Flawed video No More
Software Review by Steve Miller, VP Vendor Relations,

Brookdale Computer User Group, NJ BCUG Bytes, Sept 09

<www.bcug.org> <stevemiller1 (at) comcast.net

‘‘Do you shoot video with your cell phone, digital camera,

or other handheld device?’’ is the question found on the

website for vReveal. ‘‘Then the chances are good that you

have shaky, dark, noisy, pixilated, or blurry videos. Less-than-

ideal videos that obscure your life’s best, captured mo-

ments.’’

‘‘But those moments don’t have to be lost to common video

problems anymore,’’ the site promises. ‘‘vReveal has the

advanced enhancement technology and ‘‘one click’’ touch-

up tools that make it easy to dramatically improve the quality

of flawed videos.’’

I was impressed by vReveal’s enhancements of my video.

I was equally impressed by the dramatic speed increase

resulting from off-loading computing from my motherboard

CPU to my system video card. As advertised, vReveal im-

proves snowy/jerky/low quality video. It also exports a high

quality photo, derived from lower quality source video.

Installation

I own a compatible late-model NVIDIA graphics card

(8800GT). I downloaded the latest NVIDIA graphics driver,

which enabled vReveal software to use parallel processing by

~100 processors in my video card. During the simple vReveal

installation, I specified a video folder to be ‘‘watched’’ by the

new program.

Evaluation

My video was displayed split-screen, in order to contrast

before and after application of the video enhancements. I

discovered an important, but unadvertised use for this amaz-

ing software. vReveal improves the quality of Standard Defi-

nition (SD) video, so the contrast becomes less noticeable

when SD videos are used in the same movie with High

Definition (HD) video.

My Standard Definition video sources include traditional

SD camcorders as well as my digital still camera (in ‘‘video

capture’’ mode). My HD sources include a HD camcorder, and

digital photos, which I ‘‘pan’’ and ‘‘zoom’’ to create motion.

I used the following vReveal settings to enhance my Stan-

dard Definition video:

���� ‘‘One Click Fix’’ (this automatically ‘‘Cleaned’’, ‘‘Sharp-

ened’’, and AutoContrast’’).

���� ‘‘De-interlace’’. (‘‘de-interlace’’ is an important feature

which prevented unacceptable artifacts during video with

fast motion).

To view the result of video enhancement, I used my favorite

video editor to create one timeline that contained three types

of content.

���� Standard definition video, no enhancement

���� Standard Definition video, enhanced with vReveal

���� High Definition video

I then ‘‘burned’’ a standard DVD, and also ‘‘burned’’ a High

Definition BluRay DVD (encoded with the optional HDV

MPEG2 format). I used Cyberlink ‘‘Power DVD’’ software with

a 24 inch Samsung LCD (1680X1050) to ‘‘play’’ the DVDs, and

compare SD video (with and without enhancements) to the HD

video.

Visible results

The original (un-enhanced) SD content was clearly defi-

cient to HD video content. After enhancement, my SD content

exhibited remarkable video improvement (although not quite

up to the high definition sources): Snow (especially resulting

from low light) totally disappeared on my SD content after

enhancement. Colors were brighter, blacks were blacker, and

contrast was enhanced.

vReveal, owned by NVIDIA, includes a performance and

control dashboard to showcase the speed increase resulting

from leveraging NVIDIA video card GPU (graphics proces-

sors). My jobs ran twice as fast when I shifted the processing

from my high performance quad core to my lower-end video

card!

(Enhancement of my 40 minute SD video took about 90

minutes when off-loaded to the video card, and took about 180

minutes when confined to my high performance quad proces-

sor.)

System Requirements

Hardware: Intel or AMD 1.6GHz CPU, 1GB RAM, 50MB hard

drive space; NVIDIA video card with ‘‘CUDA’’ enabled

(GeForce 8-series, and higher); 100GB free disk per hour of

enhanced video (uncompressed AVI)

Software: Microsoft.(R) Windows XP with Service Pack 2 or

Windows Vista(TM) Home Premium, Business, Ultimate, or

Enterprise (certified for 32-bit editions).

Output file types supported: WMV and uncompressed AVIs

Price: $49, download from <www.nzone.com> 30-day trial

software is available (watermark is applied to output video

files.) For more information: <www.vreveal.com/>

This article has been obtained from APCUG with the

author’s permission for publication by APCUG member

groups; all other uses require the permission of the author

(see e-mail address above).
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EaseUS Partition Master Home Edition
by Bruce Preston, Danbury Area Computer Society, Inc.

A few weeks ago a friend of mine purchased a used desktop

machine that was one of 15 taken from an office.  The seller had

wiped the machine clean and then re-installed Windows XP

from the system restore disk in the restore partition D: partition

- 8GB and left the C: partition completely empty - 50GB.   It

wasn’t long before my friend started getting warning mes-

sages that he was running out of space on D:.  Although he

had installed his applications on C:, Windows still puts a lot

of stuff such as ‘‘Program Files\Common Files’’ on the ‘sys-

tem’ partition, in this case D:

Rather than wipe the drive clean and re-install everything

from scratch, we decided to look into resizing the partitions.

That’s when I found Partition Master Home Edition by

EaseUS.com  <www.partition-tool.com>.  The Home Edition

is free for non-commercial use and works with Windows 2000,

XP, Vista and 7.  There is a Professional Edition ($39.95) for

business use, and there is a server edition that works with the

various MS Server products.

Before using it on a ‘real’ machine with live data, I decided

to give it a test run on a throw away hard disk.  I created a virtual

hard disk on a virtual machine and set the two partitions to

about 75%/25% of the virtual drive’s space.  I then put some

files in each partition.  I ran Partition Master and was surprised

at how easy it was.  Because the virtual hard disk didn’t have

any open operating system files on it, it did the whole realign-

ment without requiring restart.

Confident that it worked I then addressed my friend’s

machine.  Operation is straightforward.  When you start it, it

presents you with a list of physical drives.  My friend’s

machine had only one physical drive, so that was an easy

choice.  You get a graphic bar that displays the current

partition sizes.  A small vertical line within the bar shows how

much space is in use within each partition. If you are resizing

you clearly can’t make the partition smaller than the space

already in use by files.

I put the mouse pointer over the heavy vertical bar that

separates the two partitions and the pointer changed to a

horizontal double-headed arrow suggesting that I could drag

it.  I dragged the bar to the left, and it indicated that the C:

partition would be shrunk to about 28GB.  The area between

the C: and D: partitions was now graphically displayed as a

gray ‘unallocated’ area.

I put the mouse pointer over the center of the D: partition

and was presented with a four-headed arrow pointer, inviting

me to drag the partition.  I slid it to the left until it adjoined the

C: partition.  I now had the unallocated area to the right of the

D: partition.

Lastly, I put the mouse pointer over the right end of the D:

partition and got the double-headed pointer again.  I slid the

end of the D: partition all the way to the right, and it indicated

that the D: partition would now be expanded to absorb the

unallocated space.

At this point the display indicated that the partitions were

ready to be resized and both of about 28GB.  I clicked APPLY

and it indicated that three tasks were queued for operation and

asked for a confirmation.  Because it was going to perform an

operation on the partition containing the operating system, it

indicated that it would require a system restart.  I approved and

off it went.

About 5 minutes or so later the machine booted to my

friend’s desktop.  We checked the drive sizes in My Computer/

Properties, and sure enough the drives had been resized.  It

was a very nice and easy process indeed.

The image shows the screen when I was working with the

test configuration on the virtual machine.  The test drive is

‘‘Disk 3’’ and displays that I have already requested the

resizing (reduction) of ‘‘G:’’ to roughly half of the partition, but

have not yet moved and expanded drive ‘‘H:’’  The gray space

between them represents the space surrendered from G:.  The

blue area on the left of the screen shows that I have one

operation in the queue.  My next operation will be to move H:

to the left, followed by extending the size of H:  When done

you click the APPLY button, and then confirm it.
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Lock your PC with a USB drive
by Kim Komando

You can’t always be in front of your computer. But stepping

away doesn’t mean leaving the computer vulnerable. There are

easy ways to keep people out of your personal business.

For instance, Windows will lock your computer when you

get up. Just click WinKey + L. This preserves your session and

brings up the log-in screen. To get back in, you have to enter

your password. That works. But there is a better way.

Predator makes locking and unlocking your PC a breeze. You

do it with a USB drive. During installation, you designate a

drive to serve as your key. Insert it while working. Take it with

you when you step away. Pulling it out locks the computer.

Plug it back in to log in. Normally, no password is needed.

If you misplace the drive, enter your password to get back in.

An alarm will sound if someone enters an incorrect password

three times. And it will log any attempts to access the PC while

you’re away. You’ll know if and when someone was trying to

snoop.

Cost: FreeB

Link: <www.montpellier-informatique.com/predator/en/

index.php?n=Main.HomePage>

System: Windows XP, Vista and 7

COMMUNICATIONS NOTES & TIPS

Go Wireless Young Man
by Jason Mills, Durham Personal Computer User’s Club

Newsletter

Durham, Ontario

Since you bought your laptop computer you’ve probably

heard more about ‘‘going Wireless’’ because of convenience.

After all that’s why you have a laptop computer, to be mobile.

Built-in wireless capabilities are becoming almost standard

equipment on most laptop and personal computers these days

for a couple of reasons. One of the primary reasons is cost.

Adding wireless capacity is so inexpensive that it would be

silly for the manufacturer not to add it. The perceived value of

any machine with wireless far exceeds the cost to add it.

Wireless is the wave of the future, so if the manufacturers want

to stay ahead of the technology curve they need to add it to

all but their most basic models.

If that’s the case with you or if I’ve simply peaked your

imagination then read a bit more becuase I’ve outlined a few

things you can do to check if your computer has wireless

capabilities. If you have and older laptop you may still be ready

to go wireless by purchasing and adapter from your local

computer retailer.

Laptops - Intel Centrino Mobile Technology

Computer manufacturers do less than a perfect job at

explaining what this means but if your laptop came with this

built in then that’s good news for you! In a nutshell, it means

that your laptop has wireless networking built right in and you

don’t have to do a thing. Intel Centrino Mobile Technology

is a marketing name for a combination of the Intel Pentium M

processor and Intel’s Pro Wireless card.

If you have Intel Mobile Technology then your computer

should have a ‘‘Centrino’’ sticker on it somewhere. If you

can’t find a sticker but you suspect you had one at one time

then simply do the following. Right click on your ‘‘My

Computer’’ icon. It’s probably on your desktop but if not then

go to your Start Menu, find My Computer, right click and

select Properties. When the menu opens look at what it says

after or under the word Computer.

On a side note, Intel Centrino Mobile Technology also

increases battery life and allows manufacturers to build

computers smaller. If you can’t find anything referring to Intel

Centrino Mobile Technology under the word Computer--

don’t worry because as long as your laptop has a free card

slot, installing wireless is a piece of cake.

Desktop Computers

If you’re not sure whether or not your desktop computer

has a wireless connection, the easiest thing to do is to simply

turn it around and look for a small aerial sticking out of the back

towards the bottom of the CPU case. If it’s there then you are

wireless enabled. On the other hand, if there’s nothing then

it’s still possible that you have a wireless device in your

computer, especially if you purchased it anytime in 2005 or

beyond. However, because it’s not the best idea (unless

you’ve done it before) to try and open up your computer to

check something I’ll show you a way to check if you’re

wireless enabled, using Windows.

Using Windows to Check Wireless Capacity

Rather than messing with your computer’s hardware to

verify what you’ve got installed, you can just as easily check

using your Window’s Device Manager. To use it, right click

My Computer, choose Manage and then click Device Man-

ager.

After you click Device Manager a list of everything you can

install will appear on the right half of the screen.
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Tacoma Open Group for Microcomputers (TOG)

New Member Application/Existing Member Change of Address Form

For Tacoma Open Group annual membership, send form  (if needed) & $25 to Bob Henkel., 10613  25th Avenue E., Tacoma, WA 98445.

Make checks payable to TOG

Please print or type.                              Date:___________________________           Sponsored by:_______________________

Member's Name:______________________________________________________________________________________________________

Address: ____________________________________________________________________________________________________________

City:___________________________________ State:___________ Zipcode:____________Plus Four _______  Country: __________________

Home Phone: ( ____ ) ________________  Work phone: ( ____ ) ____________________ E-Mail Address ______________________________

Help Lines
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TACOMA MEETING

When: Mon  10 May 2010 -7:00 PM
Where: SE Tacoma Community Centre

1614 99th Street E.
Tacoma, Washington

From I-5 take Exit 127 (Hwy 512) to
Portland Ave., north on Portland to 99th,
left over tracks. Building is on south side.

Future Dates: 2nd Monday of Month

TOG BOARD MEMBERS

President Carl Tenning (206) 824-3843

 & S. King County Rep c.10ing@toggle.org

      web page: http://carlten.tripod.com/index.html

VP/Prog Chair Vacant

Sec/Treas Bob Henkel     (253) 537-6732

    bobh@nventure.com

Disk Library Tom Stepanek (253) 922-7939

tomstep7@msn.com

Newsletter Editor Bob Thomson (253) 752-5582

     rjthomson@comcast.net

Kitsap County Rep   Ray Mills (360) 692-7568

e-mail: r.mills@rm-a.com

       web page: http://www.rm-a.com

TOG Web Site: http://www.toggle.org

======================================
Deadline:  15th  of  this  month  to   appear
in next months’ issue, if room
======================================

PROGRAMS

This Month’s Meeting

This will be a regular monthly meet-

ing. Meeting discussions are always

interesting and the ever-popular Q&A

(Question & Answer) period is sure to

pique your interest, come up to your

expectations and tickle your fancy.

Come and share your own experiences,

problems and discoveries.

No specific program presentation has

been identified at press time but lively

discussions of computer-related top-

ics are sure to come up with interesting

and informative dialogue. Be sure to

come to the meeting and participate.

Corporate Sponsors:

Raymond Mills & Associates
www.rm-a.com

How To get To The Meeting

For those readers still unfamiliar with

how to find our meeting place we have

reproduced the map showing its rela-

tionship in Tacoma to Portland Ave S.

and the 512 Freeway. The 512 Freeway

can be entered from I-5 in Tacoma on

the west or from Hwy 167 in Puyallup on

the east. Proceed to Portland off-ramp

and turn north to 99th Street. Some

folks in the middle of Tacoma may pre-

fer to take Portland southbound to 99th.

At 99th turn west over the tracks and

there you are!

Tacoma OPEN Group for Micros

1808 Lenore Drive

Tacoma, WA  98406-1920

Change Service Requested


